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If You Have Problems 
Please visit our service and support page at https://www.gamry.com/support-2/. This page contains information 
on installation, software updates, and training. It also contains links to the latest available documentation. If you 
are unable to locate the information you need from our website, you can contact us via e-mail using the link 
provided on our website. Alternatively, you can contact us one of the following ways: 

 

 Internet  https://www.gamry.com/support-2/ 

Telephone (215) 682-9330   9:00 AM−5:00 PM US Eastern Standard Time 

   (877) 367-4267    Toll-free US & Canada Only 

 

Please have your instrument model and serial numbers available, as well as any applicable software and 
firmware revisions. 

If you have problems in installation or use of a system containing Echem Analyst 2 software, please try to call 
from a phone next to your computer, where you can type and read the screen while talking to us. 

We will be happy to provide a reasonable level of free support for registered users of the Echem Analyst 2 
software. Reasonable support includes telephone assistance covering the normal installation, use, and simple 
customization of a computerized system containing Echem Analyst 2 software connected to a Windows®-
compatible computer. 

A service contract that extends the software update period is available at an additional charge. Software 
updates do not include software enhancements offered to our customers at additional cost. 

Enhancements to the Echem Analyst 2 software that require significant engineering time on our part can be 

performed on a contract basis. Contact us with your requirements. 

Copyrights 

Echem Analyst 2™ Software Operator’s Guide copyright © 2008−2024 Gamry Instruments, Inc., all rights 
reserved. 

Gamry Framework copyright © 1989−2024 Gamry Instruments, Inc., all rights reserved. 

Framework and Gamry are trademarks of Gamry Instruments, Inc. 

Windows® is a registered trademark of Microsoft Corporation. 

No part of this document may be copied or reproduced in any form without the prior written consent of 
Gamry Instruments, Inc. 

License Agreement 
Gamry Instruments, Inc. grants you, the Purchaser, a non-exclusive license to use the software programs 
included in this package, including updates which may later be provided by Gamry Instruments at additional 
cost. This license is subject to the terms and restrictions set forth in this Agreement. 

License 

The software programs and the Operator’s Guide are protected by both United States copyright law and 
international treaty provisions. Accordingly, these software programs remain the property of Gamry 

Instruments, Inc. as its sole property, subject to the rights granted to you in this License Agreement.  

https://www.gamry.com/support-2/
https://www.gamry.com/support-2/
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You may: 

• Make archival copies of the software programs for backup purposes only. All backup copies must 
include the Gamry Instruments, Inc. copyright notice. 

• Transfer the programs and Gamry potentiostat from computer to computer within your facility. 

• Operate the data-acquisition (Framework™) and data-analysis portion (Echem Analyst 2™) of the 
programs on an unlimited number of computers within your facility. 

• Transfer the programs, with a copy of this license, to another party, provided the other party agrees to 
accept the terms and conditions of this Agreement. If you transfer the programs, you must at the same 
time transfer all copies of the programs to the same party or destroy any copies not transferred. If you 
transfer possession of any copy of the software programs, in whole or in part, to another party, your 
license is automatically terminated. 

You may not: 

• Sublicense, rent or lease the software programs. 

• Use this program with a potentiostat not specifically authorized by Gamry Instruments, Inc. 

• Copy, use, modify, or transfer the software programs, Operator’s Manuals, or any copy, in whole or in 
part, except as expressly provided in this Agreement. 

Term 

This license is effective until terminated. You may terminate it by destroying or returning the programs and 
Operator’s Manuals and any copies thereof. This license will terminate if you fail to comply with any term or 
condition of this Agreement. 

Governing Law 

This License Agreement shall be governed by the laws of the Commonwealth of Pennsylvania. If any provision 
of this License Agreement is found void, invalid, or unenforceable, it will not affect the other terms and 
conditions of this Agreement, which remain valid and enforceable. 

Third-Party / Use Sublicenses 

Gamry software may incorporate Third-Party or Use Sublicenses (such as Qt or other math-related Python 
software). In this case, the terms and conditions of their License Agreements (available during Setup) will apply. 

Disclaimers 
Gamry Instruments, Inc. cannot guarantee that the Echem Analyst 2 software will work with all computer 
systems, operating systems, and third-party software applications, hardware, or software. 

The information in this guide has been carefully checked and is believed to be accurate as of the time of 
release. However, Gamry Instruments, Inc. assumes no responsibility for errors that might appear. 

No part of this document may be copied or reproduced in any form without the prior written consent of 
Gamry Instruments, Inc. 

Windows®, Excel®, and PowerPoint® are registered trademarks of Microsoft Corporation. Origin® is a registered 
trademark of OriginLab Corporation. DigiSim® is a registered trademark of Bioanalytical Systems, Inc. 
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Chapter 1: Introduction to this Guide 

The Echem Analyst 2™ software is Gamry Instruments’ dedicated data-analysis program, the companion to 
Gamry Instruments’ data-acquisition program called FrameworkTM. Data files generated by experiments in 
Framework software then can be analyzed in the Echem Analyst 2. The Echem Analyst 2 is a single program 
that runs data-analysis for all types of experiments, such as those used in DC Corrosion, EIS, and Physical 
Electro-chemistry. 

The Echem Analyst 2 is designed with the specific functions to make data analysis as straightforward as possible. 

This manual explains the most common analysis routines. The tools discussed here in the examples are 
common to many data files created by other experiments. This document is a guide and is not intended to 
have the same scope as the on-line help or a complete operating manual. In order to create a concise 
document, we assume you have a working knowledge of Windows®-based applications. We ignore details 
about common functions, such as opening, saving, and closing files, so as not to obscure the goal of this guide. 
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Chapter 2: General Information and Overview 

Installation 

The Echem Analyst 2 software is only available via download on Gamry’s website. If you already own one of 
our instruments, use Gamry's Client Portal to download the latest installation file. The latest version can be 
found here: https://www.gamry.com/support-2/software-updates-3/ 

During the installation process, you have the option to add additional features to the installation. By default, 
the Echem Analyst 2 software is already pre-selected among others such as Gamry Framework. Features you do 
not want to be installed can be manually removed or added again. 

 

Follow the next steps during the installation procedure. Once installed, you are ready to use the Echem 
Analyst 2 software. You may install copies of the Echem Analyst 2 on multiple computers. Often users prefer 
the convenience of performing data-analysis at an office workstation, rather than the laboratory setting. 

File Formats 

Gamry data files acquired using Framework software have the extension *.DTA. All *.DTA files are ASCII text, 

and therefore you can open them directly into various programs, such as Excel® or Origin®. When *.DTA 

files are opened in Echem Analyst 2, then saved, their extension becomes *.gpf. All *.gpf (Gamry Project 

File) files include information on curve-fits and graphing options, thus *.gpf files are only viewable in Echem 

Analyst 2.  

https://www.gamry.com/support-2/software-updates-3/
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Depending on the region where you live in, the number format may differ to the standard Gamry file format. 
Hence, we suggest checking the Windows® Region Settings of your computer and enabling Unicode UTF-8 
support. 

 

 

Open a Gamry Data File 

There are several different methods to open data files in the Echem Analyst 2: 

1. Launch the Echem Analyst 2 icon on your desktop. 

Then use the File > Open function.  

2. Use the link on your desktop to open the My Gamry Data folder. 

Double-click on the data file. You may have to instruct your computer to associate the *.DTA 

extension with the Echem Analyst 2 program. 

3. There are two quick ways to open a recent Gamry Data File: 

 Do not delete your *.DTA files! They are the raw data and may need to be re-loaded for 

certain analyses, such as area normalization. 

 Gamry’s previous data analysis version, the Echem Analyst, used a different file format which 
saved their data as *.GData (Gamry Data) files. These files can’t be opened anymore in the newest 

Echem Analyst 2 version and require the older Echem Analyst version. Please contact your local Gamry 
representative or Gamry support for more information or directly visit our website at www.gamry.com. 

 For best international character display support, use Unicode UTF-8 settings in Windows. 

http://www.gamry.com/
http://www.gamry.com/
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a. Within Gamry Framework, go to the Analysis menu. The last eight generated data files are 
listed for quick access. The Echem Analyst 2 automatically launches and opens the selected 
data file. 

b. Within the Echem Analyst 2, go to the File menu > Open Recent. Select a data file from the 

sub-menu. 

By default, files acquired in the Framework are saved into the My Gamry Data folder. A shortcut for My 
Gamry Data is installed on the Windows® desktop. You can change this default under Tools > Options, 
which opens the Gamry Analysis Framework Options window. Choose the General tab and change the Path 
for each type of data file as desired. 

 

The data set appears in the main window. The menu items, tabs, and toolbar are adjusted for the particular 
type of data set you chose. In the example below, a Potentiostatic EIS data set is shown: 

 

Note the tab-based display. The Experimental Setup tab displays all the information from the parameters used 
to run the experiment, such as voltage, time, etc. The Experimental Notes tab stores any notes written into the 
setup screen in Framework. The Open Circuit Voltage tab shows the voltage measured during the initial delay 

of the experiment. The Hardware Settings tab records in-formation on the filters, ranges, gains. Additional 
information on date of last calibration, software version, etc. is also stored here. 

Overlay multiple data files 

You can overlay multiple data files to compare individual data sets within a single graph. Generally, Gamry data 
files (*.DTA) with similar data format can be overlaid. Overlay compatibility depends hereby on the TAG label 

within the data file. It is listed in the second line of any Gamry data file, as shown in the example for a 

chronoamperometric file (CHRONOA) below: 

  

 Do not change the directory for any Analysis Script Files! These are the Python programs that 
do the actual analysis. 
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EXPLAIN 

TAG CHRONOA 

TITLE LABEL Chronoamperometry Scan Test &Identifier 

DATE LABEL 8/31/2004 Date 

TIME LABEL 11:41:21 Time 

NOTES NOTES 4 &Notes... 

... 

The table below shows the overlay compatibility for the various TAGs: 

TAG Experiment 

PWR800_GALVEIS 

GALVEIS 

PWR800_EISPOT 

EISPOT 

PWR800_HYBRIDEIS 

HYBRIDEIS 

PWR Galvanostatic EIS 
Galvanostatic EIS 
PWR Potentiostatic EIS 
Potentiostatic EIS 

PWR Hybrid EIS 
Hybrid EIS 

PWR800_CV 

CV 

PWR Cyclic Voltammetry 

Cyclic Voltammetry 

CHRONOA 

CHRONOP 

GALVANOSTATIC 

POTENTIOSTATIC 

MULTI_STEP_CHRONOAMP 

MULTI_STEP_CHRONOPOT 

REPEATING_CHRONOA 

REPEATING_CHRONOP 

Chronoamperometry 
Chronopotentiometry 
Galvanostatic 

Potentiostatic 
Multi-step Chronoamperometry 
Multi-step Chronopotentiometry 
Repeating Chronoamperometry 
Repeating Chronopotentiometry 

PWR800_READVOLTAGE 

CORPOT 

PWR Read Voltage 
Corrosion Potential 

POTENTIODYNAMIC 

CYCPOL 

Potentiodynamic 
Cyclic Polarization 

EISMON 

PWR800_GALVEISMON 

PWR800_HYBRIDEISMON 

PWR Single Frequency EIS 
PWR Galvanostatic Single Frequency EIS 
PWR Hybrid Single Frequency EIS 

CV 

CVEQCM 

Cyclic Voltammetry 
EQCM Cyclic Voltammetry 

CHRONOA 

CHRONOAEQCM 

REPEATING_CHRONOAEQCM 

Chronoamperometry 
EQCM Chronoamperometry 
EQCM Repeating Chronoamperometry 

CHRONOP 

CHRONOPEQCM 

REPEATING_CHRONOPEQCM 

Chronopotentiometry 
EQCM Chronopotentiometry 
EQCM Repeating Chronopotentiometry 

LSV 

LSVEQCM 

Linear Sweep Voltammetry 
EQCM Linear Sweep Voltammetry 

CPC 

CHRONOC 

CHRONOCEQCM 

Controlled Potential Coulometry 
Chronocoulometry 

EQCM Chronocoulometry 
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1. Open the Echem Analyst and a data data file (*.DTA or *.gpf). 

2. Go to the File menu > Overlay Files. The feature is grayed out if no file is open. 

3. The Open File dialog box appears. Select any *.DTA file you wish to overlay with the currently open 

file. Click Open to confirm your selection. 

4. The Echem Analyst adds the selected files to the open file. The new data sets are also listed to the right 
under Visible Traces. They can be individually selected and worked with. 

An error message appears if a data file is incompatible for overlaying. 

Merge individual data files 

Besides overlaying multiple files to compare different data sets, the Echem Analyst 2 offers an option to “stitch 
together” data files. The Merge feature allows the user to merge individual data sets which are then treated as a 

single data set. 

5. To access the feature, go to the File menu > Merge Files. 

6. The Open File dialog box appears. Select any *.DTA file you wish to merge. Click Open to confirm 

your selection. 

7. The Echem Analyst opens the selected file in a single data plot and the Merge dialog box as shown 

below. 

 

8. Each individual data set shows two numbers at the beginning and end of their data curve. They depict 
the order of merged data points, following the order 1 → 2 → 3 → 4 → etc. 

 

 The curve order and subsequentially the point order is important. Once merged, data points 
will follow this order. Any data fit will be calculated incorrectly if the order is not correct, e.g., if EIS data are 
arranged from mid to high to low frequencies. 
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9. Change the order for merging in the Merge dialog box. Select a curve and move it up or down in the 
order using the arrow symbols on the right side. You will notice that the numbers in the data plot will 
change accordingly, with the top curve starting from 1 → 2, the second curve 3 → 4, etc. 

10. If required, reverse a data set’s sequence by pressing the Reverse Point Sequence button. 

11. Press Merge when done. The new “merged” data plot is shown with the file now being treated a single 
data set. 

 

Working with Plots in the Echem Analyst 2 

Menu 

The Echem Analyst 2 displays at the top line the menu bar. Three functions are universal which are File, Help, 

and Tools. 

• File 
o Open, overlay, merge, and save data files, print your data, and exit the software 

• Help 
o Includes the user manual and software information 

• Tools 
o Tools to customize software scripts 
o Options to customize the graph interface 
o Perform EIS Batch Fit on your data 

The other commands in the menu depend on the data file and the experiment type. The raw data file 
(*.DTA) includes a line that indicates the type of experiment used to generate the file in Echem Analyst 2. 

The first command is named after the experiment type and includes experiment-specific commands. The 

second is called Common Tools and includes various functions to format the graph, see Chapter 3:Common 
Tools. 
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Menu toolbar 

The most common file commands are separately listed in the Menu toolbar below the Menu bar. 

 

The following chart lists all commands on the Menu toolbar. 

Table 2-1 
Menu toolbar functions 

Button Name Function 

 
Open File Open a *.DTA or *.gpf data file. 

 
Open Overlay Open a *.DTA file of the same experiment type to overlay with the 

current data. 

 
Save Save data file as Gamry Project File (*.gpf) 

 
Print Print the plot. 

 
Exit Close the Echem Analyst 2. 

Graph toolbar 

The Echem Analyst 2 boasts a number of graphical tools to help you get the most information out of your data. 
After you open a data set, these tools appear in the toolbar immediately above the plot. 

 

The Graph toolbar includes general functions for replotting, graph formatting, and data handling. The following 
chart lists all commands on the Graph toolbar. 
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Table 2-2 
Graph toolbar functions 

Button Name Function 

 
Copy to clipboard Copy the selection to the Windows® clipboard. Paste the file directly in 

Microsoft programs for reports or presentations. 

 
Select X Region Select a desired region of the plot across the x-axis. 

 Select Y Region Select a desired region of the plot across the y-axis. 

 
Select Portion of Curve 
using the Mouse 

Left-click on the active trace using the mouse to select a section of the 
curve. 

 
Draw Freehand Line Draw a line on the plot. 

 Enable/Disable Points Enable or disable points settings. 

 
Show/Hide Disabled 
Points 

Show or hide data points not being used in the plot. 

 
Pan Let’s you see different areas of a zoomed view. 

 
Zoom Zoom in on a selected region. 

 
Auto-Scale Automatically adjust x-axis and y-axis range to display the full curve. 

 
Vertical Grid Toggle between showing and hiding vertical grid lines on the plot. 

 
Horizontal Grid Toggle between showing and hiding horizontal grid lines on the plot. 

 
Properties… Open the GamryChart Properties window, so that you can adjust 

effects, colors, markers, lines, etc. 

 
Print Chart Print the plot. 
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Changing the Axes on a Plot using the Curve Selector 

To choose a different variable plotted on an axis, use the Curve Selector button as follows. The example 
shown below is a Differential Pulse Voltammetry plot: 

1. With the plot open and displayed on the screen, click the Curve Selector button on the right side. 

 

The Curve Selector area appears on the right side of the window. 

2. Choose which trace is active by clicking the drop-down menu in the Active Trace area. 

The Active Trace is the data series on which the analysis will be performed. Use this if multiple files or 
cycles are displayed on the graph. 

3. Choose which trace is visible on the plot by activating the checkbox next to the desired trace(s) in the 
Visible Traces area. 

Visible Traces also contains any data fits that are performed. 

4. Choose which variable is plotted on the x-axis by highlighting the variable in the X-Axis column. 

5. Choose which variable is plotted on the y-axis by highlighting the variable in the Y-Axis column. 

6. Choose which variable is plotted on the second y-axis by highlighting the variable in the Y2-Axis 
column. 

 

  

 If there is a data column graphed on the Y2-Axis, those data appear in a different color and a 
different scale. 



General Information and Overview – Selecting Portions of a Curve for Analysis 

18 

Selecting Portions of a Curve for Analysis 

For certain types of analysis, you must select a region of the curve, for example, within the Peak Find function 
in Cyclic Voltammetry or Tafel Fit function in Potentiodynamic. 

• Left-click the mouse on the Select Portion of Curve using the Mouse button in the Graph Toolbar. 

 

• Use the left mouse-button to select each endpoint of the curve. Each endpoint is marked with a blue 
cross. The selected portion of the curve is shown as a thick blue line. In the figure below, the color of 
the data was changed to red for contrast to the selected region. 

 

• Another click on the Select Portion of Curve using the Mouse button clears the selected region and 
readies the graph for a different region to be selected. 

Enable/Disable Points of a Curve 

In some cases, measurement data can contain data points that are clear outliers caused by noise or other 
sources or some points are not useful for fitting data. In such cases, points can be disabled and back again 
enabled. 

Disable Data Points 

1. In the Graph Toolbar, click the Enable/Disable Points button. 

2. The Disable/Enable Points settings window appears. 
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3. Select the Disable mode. 

If you want to disable only single points, select Point on the right side. 

For disabling a range of data points, select Series on the right side. 

4. Within the data plot, select the points you want to disable. All marked points are highlighted by a 

blue . 

 

5. Confirm or discard your selection by either right click your mouse 

 

or click the Enable/Disable Points button in the Graph Toolbar. 
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6. The data curve is shown without the disabled data points. 

 

7. If you want to see all the disabled points in your data curve, click the Show/Hide Disabled Points 
button in the Graph Toolbar. 

All disabled points are highlighted with a red . 

 

Enable Data Points 

1. In the Graph Toolbar, click the Enable/Disable Points button. 

2. The Disable/Enable Points settings window appears. 
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3. Select the Enable mode. 

If you want to enable only single points, select Point on the right side. 

For enabling a range of data points, select Series on the right side. 

4. The data plot shows all disabled points highlighted by a blue . 

Select the data points you want to enable again. The selected points are highlighted by a green . 

 

5. Confirm or discard your selection by either right click your mouse 

 

or click the Enable/Disable Points button in the Graph Toolbar. 

 

6. The data curve is shown with all the enabled points again and without the remaining disabled data 
points. 
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7. If you want to see all the disabled points in your data curve, click the Show/Hide Disabled Points 
button in the Graph Toolbar. 

All disabled points are highlighted with a red . 

Cut and Paste Images and Data 

Many users want to present, publish, or otherwise share their data and charts from the Echem Analyst 2. The 
Copy to Clipboard button allows to copy data as an Image or as Text (data only) to the clipboard for further 
processing. 

As an Image 

1. In the Graph Toolbar, click the Copy to Clipboard button. 

 

2. In the drop-down menu select As an Image. 

3. An image of the graph enters the clipboard. You can paste this file into a presentation program such as 
Word® or PowerPoint®. 

This is a quick and easy way to import a picture of the graph for a presentation or report 

As Text  

1. In the Graph Toolbar, click the Copy to Clipboard button. 

2. In the drop-down menu select As Text . 

3. The Gamry Data File is copied in ASCII format to the clipboard. 
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Because Gamry Data Files are ASCII text, they can be opened easily in other graphing programs, such 
as Excel® or OriginLab®. Right-click on the DTA file, select Open With…, and select your desired 
program. These programs, however, do not contain fitting routines specific to the analysis of 
electrochemical data. This As Text feature lets you fit the data in Echem Analyst 2 and then copy and 

paste the data and fit into another graphing program. 

This is a quick and easy way to import both the data and the fit into another graphing program. 

 

Plotting Conventions 

By right-clicking the mouse on a non-zero value on an axis, you can choose to show that particular axis in Log 

Scale (logarithmic) or linear scale (when Log Scale is inactive). 

 

You can also use the Transform Axes selection (if available) under the Common Tools menu.  

 

• The Transform Axes window appears. 

 If you are using the As Text feature, be sure to note the currently graphed parameters. The 
coordinates of the currently displayed graph are copied and can be pasted to other graphing programs. 
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You can also reverse the direction of the numbers when Reversed is active. 

 

 

Getting Online Help and Version Number 

In the main menu, choose Help. 

 

• Click User Manual to open the Echem Analyst 2 operator’s guide and obtain information about 
various commands and functions of the Echem Analyst 2. 

• Click About Echem Analyst 2 to view the software version number. 

 

 Axis display options vary, depending on the selected experiment type. Non-available options 
are either grayed out or not listed. 

 Default plotting of graphs is auto-scale. Therefore, note the y-axis’ scale when a plot first 
appears. If bad data points obscure your data because of auto-scaling, you can choose to disable and hide 
those offending points. 
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Chapter 3: Common Tools 

While each type of experimental data has its own method and parameters, there are certain commands that 
are common to many analyses. This section shows you these Common Tools. 

Accessing Common Tools 

1. Open a dataset. 

In the menu, the function Common Tools appears. 

2. Choose Common Tools. 

A drop-down menu appears. 

 

3. Select the desired command. 

In this example, Chronoamperometry’s Common Tools includes five commands: Add E Constant, 
Add I Constant, Post-Run iR Correction, Linear Fit, and Smooth Data. 

Note that Linear Fit is inactive. This command requires at first to select a portion of the curve to be 
active. 

 

 The list of Common Tools functions varies depending upon the type of experiment. 
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Table 3-1 
List of Common Tools functions 

Command Type of experiment Result 

Add E 
Constant 

Cyclic Voltammetry, DC Voltammetry, 
Differential Pulse Voltammetry, Galvanic 

Corrosion, Normal Pulse Voltammetry, Pitting 
Scan, Polarization Resistance, Potentiodynamic 
Scan, Square-Wave Voltammetry 

Adds a constant potential to all 
voltages in the plot. Used to easily 

convert between different Reference 
Electrode’s scales. 

Add I 
Constant 

Chronoamperometry, Chronopotentiometry, 
Cyclic Voltammetry, Galvanic Corrosion, Pitting 

Scan, Polarization Resistance, Potentiodynamic 
Scan 

Adds a constant value to all currents in 
the plot. 

C from CPE, 
omega(max) 

Potentiostatic EIS, AC Voltammetry, Mott-
Schottky 

Calculates capacitance from 
previously fit CPE values and data 

from the Nyquist plot. 

C from CPE, 
R(parallel 

Potentiostatic EIS, AC Voltammetry, Mott-
Schottky 

Calculates capacitance from 
previously fit CPE and fit R data. 

Linear Fit Chronoamperometry, Potentiostatic EIS, AC 
Voltammetry, Chronocoulometry, 

Chronopotentiometry, Cyclic Voltammetry, DC 
Voltammetry, Differential Pulse Voltammetry, 
EMF Trend, Galvanic Corrosion, Mott-Schottky, 
Normal Pulse Voltammetry, Polarization 
Resistance, Potentiodynamic Scan, Square-Wave 
Voltammetry 

When a region of the plot is selected, 
fit the data to y = mx + b. 

Post-Run iR 
Correction 

Cyclic Voltammetry, Polarization Resistance, 
Potentiodynamic Scan 

Corrects a previously run scan for 
voltage-drop caused by iR. 

Smooth Data Chronoamperometry, Chronopotentiometry, 
Cyclic Voltammetry, DC Voltammetry, 

Differential Pulse Voltammetry, EMF Trend, 
Galvanic Corrosion, Normal Pulse Voltammetry, 
Pitting Scan, Polarization Resistance, 
Potentiodynamic Scan, Square-Wave 
Voltammetry 

Smooth data. Useful for locating peaks 
in regions of high data-density. 

Transform 
Axes 

Galvanic Corrosion, Pitting Scan, Polarization 
Resistance, Potentiodynamic Scan 

Changes x- and y-axes from linear to 
logarithmic, etc. 
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Chapter 4: Experiment Tabs 

When analyzing an experiment in the Echem Analyst 2 by opening a *.DTA file, the Experiment Window 

opens, displaying a default data curve. The experiment window is divided into various sub-tabs, each displaying 
various information about the measurement data, experimental setup, hardware settings, and additional notes. 

The various Experiment Tabs are discussed using a Cyclic Voltammetry experiment data file. 

Chart 

By default, graph is displayed in the Echem Analyst 2 when opening a *.DTA file. The plotted curve depends 

hereby on the experiment and is displayed within the first tab. 

Depending on the experiment, more than one chart can be listed under the Experiment Tabs. In this example, 
only one chart tab is displayed. 

 

Data points, axis format, and graph layout can be formatted using the toolbar functions and 
experiment-dependent menu functions. 

Experimental Setup 

The Experimental Setup tab shows the experiment parameters set in Gamry FrameworkTM software. 
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This example has many of the same parameters as other experiments. It shows: 

Parameter Information 

Initial E, Scan Limit 1, 
Scan Limit 2, Final E 

The potentials defining the waveform, and whether measured vs. 
a reference electrode (Eref) or the open circuit potential (Eoc). 

Test Identifier Adds a constant value to all currents in the plot. 

Time Time the experiment was started. 

Scan Rate How fast (in mV/s) the scan was taken. 

Step Size The interval between potentials. 

Electrode Area The size of the electrode. 

Equil. Time How much time was spent letting the electronics settle before the 
scan was started. 

I/E Range Mode Automatically adjusted or fixed I/E (Current) Range mode. 

Max Current The current value that sets the I/E Range in Fixed Mode and 
determines the range in which to start in Auto Mode. 

Conditioning Whether off or on, for how long, and under what potential. This 
Potential is vs. Reference. 

Init. Delay Whether off or on. This is when the Eoc is measured. 

Cycles Number of how many voltammetry cycles were run. 

IR Comp If IR Compensation was used and the mode. 

Open Circuit The value of the open-circuit voltage (Corrosion Potential). It is 
the value of the last point in the Initial Delay. 

Sampling Mode Data-acquisition mode (for Reference family Potentiostats). 

Experimental Notes 

Any notes entered in the FrameworkTM software are automatically displayed in the Experimental Notes tab. 

You may enter any additional comments about the experiment in the Notes… field. 

 

This is a version of a modern laboratory notebook. Enter as many details about your experiment as you can. 
Information here can help you avoid having long strings of descriptive file names. 
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Electrode Settings 

The Electrode Settings tab documents any specific settings and information about the electrode used in the 
experiment, e.g., Electrode Type. The Electrode Settings tab is not available for all experiments. 

 

Hardware Settings 

The Hardware Settings tab documents the hardware settings that were used when the experiment was run, 

e.g., everything from the offsets, filters, and gains to the last time the potentiostat was calibrated. 

 

The Hardware Settings displayed in this example are listed in the table below. A detailed explanation of these 
parameters is beyond the scope of this guide. 
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Parameter Information 

Potentiostat Shows the potentiostat’s label. 

Control Mode How the experiment was controlled. 

Control Amp Speed Shows the speed of the control amplifier. 

I/E AutoRange Shows if the I/E AutoRange function was enabled. 

Ich AutoRange Shows if the Ich AutoRange function was enabled. 

Ich Range Shows the Ich range (gain). 3 volts = ×1 Gain. 

Ich Filter Shows the Ich cut-off filter frequency. 

Ich Offset Enable Shows if Ich Offset was enabled. 

Ich Offset Shows the Ich offset voltage. 

Positive Feedback IR Comp Shows if the IR positive feedback was enabled. 

I/E Range Lower Limit Shows the lowest available I/E Range available to use in this 

experiment. 

Ach Select Shows the input connector for Ach. 

DC Calibration Date Shows the date of last DC calibration 

Framework Version Shows the Framework Version when experiment was performed. 

Pstat Model Gives the model number of the potentiostat. 

Current Convention Shows which currents are positive. 

I/E Stability Shows the I/E stability speed. 

I/E Range Shows the I/E (or current) range used. 

Vch AutoRange Shows if Vch autoranging is enabled. 

Vch Range Shows the maximum value for Vch. 

Vch Filter Shows the Vch cut-off filter frequency. 

Vch Offset Enable Shows if Vch Offset was enabled. 

Vch Offset Shows the Ich offset voltage. 

Positive Feedback Resistance Shows the positive feedback resistance applied to the system. 

Ach Range Shows the voltage range of the auxiliary channel. 

Cable ID Gives the type of cable connected to the system (for Reference 

family potentiostats only). 

AC Calibration Date Shows the date of last AC calibration. 

Instrument Version Shows the Firmware Version of a Reference family potentiostat. 
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Open Circuit Voltage 

The Open Circuit Voltage tab is active if the experiment includes an open circuit potential measurement 
before the actual experiment. It is required for any experiment that uses potential reference versus Eoc. 

 

 

 

 Because default plotting of graphs is auto-scale, please note the y-axis‘ scale when the Open 
Circuit Voltage first appears. 
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Chapter 5: Analysis of Cyclic Voltammetry Data 

The figure below shows the cyclic voltammogram of a sample cyclic voltammetry file that installs in \My 

Gamry Data\ when Gamry Instruments’ Framework software is installed. 

Figure 5-1 
Cyclic Voltammogram of Ferricyanide in an aqueous NaCl solution on a Pt working electrode 

 

Cyclic Voltammetry Special Tools 

This menu analyzes the cyclic voltammetry data. 

1. In the main menu, choose Cyclic Voltammetry. A drop-down menu appears. 

 

2. Choose the desired tool. 



Analysis of Cyclic Voltammetry Data – Integrating the Voltammogram 

34 

Tool Function Notes 

Min/Max Finds the minimum and maximum currents and 
voltages within the dataset. Results appear in a 
window below the plot. 

 

Quick Integrate Integrates to find the total charge. Results appear 
in a window below the plot. 

For multi-cycle CV 
experiments. 

Integrate Integrates over a specified portion of the plot to 
find the total charge. 

Portion of the curve must 
be selected. 

Region Baselines Defines a line as the baseline for a specified 
region. 

Region must be selected. 

Normalize by Scan 
Rate 

Normalizes the dataset based on the scan rate.  

Normalize by Square 
Root of the Scan Rate 

Normalizes the dataset based on the square-root 
of the scan rate. 

 

Peak Find Finds peaks within a specified region of the 
dataset. 

Portion of the curve must 
be selected. 

Clear Peaks Clears all peaks found within the dataset. Peaks must be identified. 

Automatic Baseline Finds the baseline automatically. Peaks must be identified. 

Peak Baselines Defines a line as a baseline for a specified peak. Peaks must be identified. 

Clear Lines Clears all lines from the dataset. Lines must be associated 
with graph. 

Delta Ep Finds the potential difference between two 
peaks. 

Peaks must be identified 

Subtract Background 
from File 

Subtracts a background amount from the 
dataset. 

 

Export to DigiElch Exports the file to a DigiElch-compatible format.  

Options Changes units and grids for plotting the data.  

Integrating the Voltammogram 

All integration methods integrate current versus time to get the total charge. There are two different ways to 
integrate under a curve with Echem Analyst 2. 

Integrate 

Integrate requires you first to select a portion of the curve. See how to select a portion of the curve in the 
“Selecting Portions of a Curve for Analysis paragraph in Chapter 2. After an integration is performed, you can 
change the baseline from the default 0 A to another line, either a line that you draw, or an Automatic 
Baseline. 

1. Open the data file. 

2. Select the Draw Freehand Line button. 
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3. Left-click and hold on the graph to place an anchor point. Holding down the mouse button, extend 
the line with the mouse. Move or extend the line as you wish. 

4. Click next to the line to accept. After you accept the line, it turns from blue to a black solid line. The 
line is added to the Visible Traces window on the right side where the line can be edited or deleted. 

 

5. Select the portion of the curve to integrate. This function is described in detail earlier. 

6. Select Integrate from the Cyclic Voltammetry menu. 
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This integrates the selected section between the curve and the zero line and display the calculated 
charge of the area. 

7. To change the baseline to the desired user-drawn line, select Region Baselines from the Cyclic 
Voltammetry menu. 

 

The Region Baseline Settings window appears. 

8. Select the desired baseline from the available lines. You may draw multiple lines from which to 
choose. 

The integrated region moves from the default 0 A baseline to the user-drawn line. 
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Chapter 6: Modeling Polarization Resistance Data 

Polarization Resistance Special Tools 

This menu analyzes the polarization resistance data. 

1. In the main menu, choose Polarization Resistance. 

 

A drop-down menu appears. 

2. Choose the desired tool: 

Tool Function 

Min/Max Finds the minimum and maximum currents and 
voltages within the dataset. Results appear in a 
window below the plot. 

Polarization Resistance Within a selected portion of the curve, finds the 
polarization resistance. 

Polarization Resistance 
Options 

Changes units and grids for plotting the data. 

Finding the Polarization Resistance 

Method 1: Manual Entry of the Tafel Constants 

Finding the Polarization Resistance requires you first to select a portion of the curve. See how to select a 
portion of the curve in the “Selecting Portions of a Curve for Analysis” paragraph in Chapter 2. 

1. In the main menu, choose Polarization Resistance. 

A drop-down menu appears. 

 

2. Choose Polarization Resistance. 

The Polarization Resistance window opens. 
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3. In the Seed Values area, enter anodic (Beta A) and cathodic (Beta C) Tafel constants. 

4. Click the Calculate button. 

5. The calculated Corrosion Rate appears in a window below the plot. 

Method 2: Automatic Selection of Voltage Region 

The Echem Analyst 2 offers another way to automatically select the voltage region over which this analysis is 
done. 

1. In the Polarization Resistance menu, choose Polarization Resistance Options. 

 

The Polarization Resistance Options window opens. 

 

2. Select the Automatic radio button, specify the region around Ecorr to use, and click the Save as 

Defaults button. You are prompted directly for Tafel constants when a polarization resistance file is 
opened. 

This is how Gamry Instruments’ RpEc Trend experiments calculate the corrosion rate. 
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Chapter 7: Modeling Potentiodynamic (Tafel) Data 

A Tafel experiment is also a very popular electrochemical corrosion technique. The following analysis is 
performed on the sample Potentiodynamic data file. 

Tafel Fit 

1. Select the region over which to perform the Tafel fit. This region must encompass the Ecorr (open-
circuit potential). 

2. Select Tafel Fit from the Potentiodynamic menu: 

 

3. A Tafel Fit window appears where you may input seed values optionally for the fit. 

 

The better the information we provide the fitting routine, the more likely it will be able to generate an 
acceptable fit. 

If you have reasonable starting parameters for the fit, input them in the Seed Values area, and check 

the Use Seed Values checkbox. If you do not have any confidence at all in your range of parameters, 
do not check the Use Seed Values checkbox. 

We recommend using the seed values supplied by the Echem Analyst 2. 
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4. Click the Calculate button. 

5. When you click the Calculate button, the changes can be subtle. The following events occur: 

• The parameters in the Tafel Fit window become the fit parameters. 

• A fit line is displayed on the graph. 

• A new Tafel tab is created (to the right of the Hardware Settings tab) that holds the 
information about the fit. 

  

E Log I Fit 

The E Log I fit is a useful fit if you want to fit the data one branch (anodic or cathodic) at a time. This can be 
important if one branch doesn’t show linear behavior, but the other does. 

The fit is called E Log I because of the semi-logarithmic nature of a Tafel plot. The x-axis is the logarithm of 
current, while the y-axis is potential on a linear scale. 

Method 

1. Select a portion of the curve. 
Here you need only the linear section of one of the branches. This selection does not include Ecorr, 
i.e., Eoc (open-circuit potential). 

2. Select E Log I Fit  from the Potentiodynamic menu. 

 

3. In the E Log I Fit window, enter an approximate value for Ecorr. 
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4. Click the Calculate button. 

A single branch of the Tafel data is fit. The fit is shown on the graph, and the results of the fit are 
contained in a new E Log I tab. 

  

You can run a Polarization Resistance fit on these Potentiodynamic data if the axes of current are changed to 

the linear scale. Generally, we suggest running a separate experiment on a new sample of the same material 
because of the more polarizing, more destructive nature of the Potentiodynamic experiment. 
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Chapter 8: Modeling EIS Data 

The data-analysis features shown here are common to many of the AC-based techniques. By far the most 
popular type of AC experiment is Potentiostatic EIS. 

Bode and Nyquist Plot View 

Click the Bode tab or the Nyquist tab of the plot you prefer to work with. All fits are displayed on both the 
Bode and Nyquist plots. Because they are different representations of the same data, the fit results are identical. 

Figure 8-1 
Bode plot 

 

Figure 8-2 
Nyquist plot 
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EIS Special Tools 

EIS data-analysis uses an equivalent-circuit approach. This menu creates and runs fits for EIS data. Commands 
in this menu allow you to build an equivalent-circuit model in the Model Editor, then fit that model to your 
data. This menu also lets you run advanced procedures, such as Subtract Impedance, and run Kramers-

Kronig transforms. 

1. In the main menu, choose Impedance. 

2. A drop-down menu appears. 

 

3. To create or edit an equivalent circuit, choose Model Editor. 

4. The Impedance Model Editor window appears. See the next page for how to use it. 

5. Choose your fitting method. 

To fit the data using the Levenberg-Marquardt method, choose Fit A Model (Levenberg-Marquardt 

Method). 

• The Select Model File window opens. 

• Choose the appropriate model file and click the OK button. 

To fit the data using the Simplex method, choose Fit A Model (Simplex Method). 

• Simplex method weighs the user’s seed values less. We recommend using the Simplex 
method. 

6. To subtract an impedance from the data, choose Subtract Impedance…. 

7. The Impedance Subtraction window appears. 

8. Choose your parameters: 

Method Function 

Element Choose a circuit element from the drop-down 
menu. 

Model Browse for a previously defined model. 

Spectrum Browse for a data-set. 

Click the Close button. 
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9. To use the Kramers-Kronig method, choose Kramers-Kronig. Kramers-Kronig is a model-
independent transform that checks the EIS data for consistency. 

The Kramers-Kronig window appears. 

10. To clear all fits from the plot, choose Clear All Fits. 

11. To change time or impedance units, choose Options. This option lets you normalize the data and fits 
to the normalized area. 

The Model Editor 

The Impedance Model Editor allows you to create an equivalent circuit. You can select between a variety of 
circuit elements to build your own model or open a pre-built model. 

 

 

  

 There are several pre-loaded models. Often users find it convenient to start with one of these 
models and edit it as needed. 
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Figure 8-3 
Circuit Elements 

Symbol Element Comments 

 

Resistor Abbreviated as R. 
Z = R 

 

Capacitor Abbreviated as C. 

Z = –i/C 

 

Inductor Abbreviated as L. 

Z = iL 

 

Constant Phase 
Element 

Models an inhomogeneous property of the system, or a property 
with a distribution of values. Often abbreviated as CPE. 

 

Connection Node Add a connection to the model. 

 

Gerischer Element Models a reaction in the surrounding solution that happened 
already; also used for modeling a porous electrode. Often 

abbreviated as G. 

 

Infinite Warburg Models a linear diffusion to an infinite planar electrode. Often 
abbreviated as W. 

 

Bounded Warburg Models diffusion within a thin layer of electrolyte, such as 
electrolyte trapped between a flat electrode and a glass 

microscope slide. Often abbreviated as T. 

 

Porous Bounded 
Warburg 

Models diffusion through a thin layer of electrolyte, such as 
electrolyte trapped between an electrode and a permeable 

membrane covering it. Often abbreviated as O. 

 

Bisquert Open (BTO) Transmission line with ZB ≡ ∞ boundary condition. Only pore 
reactions are considered; base electrode is insulating. 

 

Bisquert Short (BTS) Transmission line with ZB ≡ 0 boundary condition. Only pore 
reactions are considered; electrode is non-insulating. 

 

Unified (UTL) Transmission line with a variety of free parameters. 

Building an Equivalent Circuit 

1. Adding an element: 

• Left-click on an element symbol. 

• Left-click on the open area to place the element. 

2. Connecting elements: 

• Click on the Add Connector Line symbol in the toolbar. 
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• Left-click one end of the wire and drag the end to the element. 

The element’s border turns blue when the wire’s end reaches the element. 

• Add a Connection Node if additional connections are required. 

 

Here is an example of a simple equivalent circuit (a Randles model) constructed in the Impedance Model 
Editor: 

 

3. Deleting an element: 

• Right-click on the element. 

The Delete command appears. Press Delete. 

• Left-click on the Delete symbol in the toolbar. 

 

Left-click on any element to be deleted. 

4. Relabeling and fixing parameters for an element: 

 Be sure to connect the circuit to the reference-electrode symbol  and the working-

electrode symbol . 
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The Set Item Parameter tool lets you rename the element, specify its parameters, and set a Lower and 
Upper Limit for its value. Renaming the element helps you distinguish between elements of the same 
type during fitting. Giving the program limits on the parameters may help the mathematical algorithm. 
For example, we know values are generally positive, so a Lower Limit = 0 is reasonable to set. There 

are two way to set element parameters: 

• Left-click on an element. 

Left-click on the Set Item Parameter symbol in the toolbar. 

 

The Set Parameter window appears. 

• Right-click on the name of the element (in this example a resistor). 

The Set Item Parameter command appears. Press Set Item Parameter. 

The Set Parameter window appears: 

 

• Enter a new Parameter Name. 

• Enter an Initial Value, i.e., the first trial value for fitting. 

• In the Lower Limit Test and Upper Limit Test fields, enter lower and upper limits, and check 
the Enable checkbox, as desired. 

• Click the OK button. 

The Set Parameter window closes and the element is set to these parameters. 

Compiling the Equivalent Circuit 

When the equivalent circuit is complete, the circuit can be compiled before use to check for connectivity of 

the wires. Compiling is only used to check connections 

1. Click File > Compile in the Model Editor menu. 
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The software compiles the equivalent circuit. 

2. If there is a problem, such as a missing connection, an error message appears, and a red box outlines 
the problem element. 

Click the OK button to continue. 

3. Inspect the schematic and make necessary corrections. 

If the equivalent circuit compiles properly, a message appears to confirm the successful compiling 
process. 

 

Click the OK button to continue. 

4. Save the equivalent circuit with an *.mdl extension by clicking the Save Model File button in the 

toolbar. 

 

The File Save As window appears. 

The default folder for saving model equivalent circuits is the Models folder. 

5. Name and save the file here or choose a different folder. 

The File Save As window closes. 
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Fitting the Data to the Equivalent-Circuit Model 

1. With the data open and plotted, click Impedance, and choose Fit A Model (Simplex Method). 

 

The Select Model File window appears. 

2. Choose the desired model. 

The default folder for models is the Models folder. This Models folder is by default in the 
C:\ProgramData\Gamry Instruments\Echem Analyst 2\models directory. 

Click the Open button. 

3. The Select Model File window closes and the Impedance Fit by the Simplex Method window 
appears. 

 

4. Click the AutoFit button or set parameters. 

Enter estimates for all the circuit elements in the Model Parameters area. Fix particular elements by 
enabling their Lock checkboxes. 

• In this example, we try 50 Ω for Ru, 1000 Ω for Rp, and 10 µF for Cf and leave all of them 
free (unlocked). 

5. If you don’t use the AutoFit button, click the Calculate button to start the fit. 

The software attempts to fit the model to the data. When finished, the fitted parameters appear next to 

each circuit element. 

The model in this example gives following fit parameters: 

• Rp = 3 kΩ 

• Ru = 199.7 Ω (solution resistance) 

• Cf = 980 nF 
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Like other Echem Analyst 2 fits, the fit also appears superimposed upon the data and a new tab is created that 
contains those results. 

 

If you try another fit using the same model, it will display a second fit and add a counter to the fit’s name. If 
you fit to another model, the fit results of both models will be displayed. 

This new tab shows the residual errors and goodness of fit, along with the various plotting tools. Residuals are a 
point-by-point Goodness of Fit, which quantifies how closely the data match the fit. A smaller number 
indicates a better fit. 

 If your fit fails, try different starting Model Parameters, or even a different equivalent-circuit 
model. 
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The blue data (Zreal) correspond to the y1-axis (on the left); the green data (Zimag) correspond to the y2-axis 
(on the right). 
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Appendix A: Headings in Data-File Columns 

DC Data Files 

Abbreviation Meaning 

Pt Point number 

T Time 

Vm, Vf Measured voltage 

Im Measured current 

Vu Uncompensated voltage 

Sig Signal from the signal generator 

Ach Auxiliary channel 

IE Range I/E (Current Measurement) range on which measurement was made 

Over Any overloads. Numeric record of different overload types 

0 No overloads 

EIS Data Files 

Abbreviation Meaning 

Freq Frequency 

Zreal, Zimag, 
Zmod, Zphz 

Calculated values of impedance 

Idc, Vdc DC component of current and voltage 

Yreal, Yimag Admittance (calculated from Z) 





Current Conventions According to FrameworkTM and Echem Analyst 2 

55 

Appendix B: Current Conventions According to FrameworkTM and 
Echem Analyst 2 

The current convention in the Framework software for all experimental packages is that an anodic/oxidation 
current is positive. 

To change the current convention (whether anodic/oxidation currents or cathodic/reduction currents are 
positive), in the menu Tools > Options > Units tab, specify the current you want represented as positive. The 
current convention can be changed by editing the experimental script (contact Gamry Instruments or your 
Gamry Instruments representative if you need to do this). Regardless of the current convention used in the 
Framework, it can be changed in the Echem Analyst 2 to the one you desire (see below for exceptions). 

 

To change the current convention in the Echem Analyst 2, in the menu Tools > Options > Units tab specify 
the current you want represented as positive 

To change the current convention in other experimental packages (DC Corrosion, EIS, etc.) please contact 
Gamry Instruments or your Gamry Instruments representative. 

 

 The current convention affects all experiments run under the Physical Electrochemistry and 
Pulse Voltammetry heading. No other data files are affected. 
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Appendix C: Index 
  

*.DTA, 9, 10, 13, 14, 27 

*.GData, 9 

*.gpf, 9, 13 

*.mdl, 49 

  

AC Calibration Date, 30 
Ach, 53 
Ach Range, 30 

Ach Select, 30 
Active Trace, 17 
Add Connector Line, 46 
Add E Constant, 25, 26 
Add I Constant, 25, 26 
Analysis menu, 11 

As an Image, 22 
As Text, 22, 23 
ASCII, 9, 22 
AutoFit, 50 
Automatic, 38 
Automatic Baseline, 34 
Auto-Scale, 16 

  

Beta A, 38 
Beta C, 38 

Bisquert Open (BTO), 46 
Bisquert Short (BTS), 46 
Bode plot, 43 
Bounded Warburg, 46 
  

C from CPE, omega(max), 26 
C from CPE, R(parallel), 26 
Cable ID, 30 
Calculate, 38, 40, 41, 50 
calibration, 30 

Capacitor, 46 
Changing the Axes, 17 
Chart, 27 
Clear All Fits, 45 
Clear Lines, 34 
Clear Peaks, 34 

Client Portal, 9 
Common Tools, 14, 23, 25, 26 
Compile, 48 
computer, 3, 4 
Conditioning, 28 
Connection Node, 46, 47 
Constant Phase Element, 46 

contract engineering, 3 
Control Amp Speed, 30 
Control Mode, 30 

Conventions, 23, 30, 55 
Copy to Clipboard, 16, 22 
Corrosion Rate, 38 
Current Convention, 30 

Curve Selector, 17 
Cut, 22 
Cycles, 28 
Cyclic Voltammetry, 18, 33, 35, 36 
  

data fit, 17 
DC Calibration Date, 30 
Delete, 47 
Delta Ep, 34 

DigiElch, 34 
Draw Freehand Line, 16, 34 
  

E Log I Fit, 40 
E Log I tab, 41 
Ecorr, 40 
EIS, 43, 44 
Electrode Area, 28 
Electrode Settings tab, 29 
element, 46, 48 

Enable, 48 
Enable/Disable Points, 16, 18, 20 
Equil. Time, 28 
equivalent circuit, 46, 48, 49 
Excel®, 9 
experiment tab, 27 
experiment window, 27 

Experimental Notes, 11, 28 
Experimental Setup, 11, 27 
Export to DigiElch, 34 
  

File, 14, 48 
File menu, 11 
File Save As window, 49 
Final E, 28 
Firmware version, 30 

fit, 17 
Fit A Model (Levenberg-Marquardt Method), 44 
Fit A Model (Simplex Method), 44, 50 
Framework version, 30 
FrameworkTM software, 7, 27, 28, 55 
Freq, 53 
  

GamryChart Properties, 16 
General, 11 
General toolbar, 18, 20, 22 

Gerischer Element, 46 
Goodness of Fit, 51 
Graph toolbar, 15, 16 
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Hardware Settings, 11, 29, 40 
Help, 14, 24 
Horizontal Grid, 16 
  

I/E AutoRange, 30 
I/E Range, 30 
I/E Range Lower Limit, 30 
I/E Range Mode, 28 
I/E Stability, 30 

Ich AutoRange, 30 
Ich Filter, 30 
Ich Offset, 30 
Ich Offset Enable, 30 
Ich Range, 30 
Idc, 53 

IE Range, 53 
Im, 53 
Impedance, 44 
Impedance Fit by the Simplex Method window, 50 
Impedance Model Editor, 44, 45, 47 
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